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Welcome to Protect-On 

This guide explains how to install Protect-On and use it to restore your classroom 
computers to their last saved configuration. You use Protect-On to remove any viruses, 
unwanted files, or unauthorized computer programs from your computers.  

How Protect-On Works 

When you install Protect-On on a client, a storage place on the hard disk is created to 
capture all changes made while protection is on. When you restart the computer, the 
changes are discarded and the computer is restored to its last saved state.   

Turning Protection Off 

You have the option to turn protection off. This is useful when you want to perform 
maintenance on your computers. For example, you may want to install program updates 
or upgrades. When protection is turned off, any changes you make to a computer are 
saved. 

Security Measures 

Only authorized Protect-On users can make changes to protected clients. You control 
who has access to classroom computers. In addition, you can assign a password to the 
Protect-On Administrator. This is useful when sharing a computer with other users 
who do not need access to Protect-On. 
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Technical Support 

GenevaLogic offers a number of resources to help you make the most of Protect-On. 
When you need additional support, try one of the following. 

Refer to Protect-On Help 

Protect-On Help offers step-by-step instructions for common tasks. You can open Help 
from the toolbar. 

Visit Our Web Site 

Our Web site, www.genevalogic.com, offers a list of support resources, including a 
knowledge base, user documentation, and software updates. 

Contact Our Technical Support Team 

You can contact Technical Support through by phone, e-mail, or our Web site. 

In North America  All Other Locations 

Phone: 866-725-7803 (toll free) 

E-mail: support.us@genevalogic.com 

Web: www.genevalogic.com 

Our hours are 7:30 AM–4:30 PM Pacific 
Time. 

Outside of North America, the technical 
support of our products is provided through 
our international network of distributors and 
resellers. Please contact the local 
GenevaLogic distributor in your area. For a 
list of distributors, visit our international 
support page at www.genevalogic.com. 

 

http://www.genevalogic.com/
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Install Protect-On 

Installation Options 

There are two ways to install Protect-On on your classroom computers. Use the table 
below to determine which installation method is best for you.  

Installation Tool Intended Use 

Protect-On Installer Manual installations; one computer at a 
time. 

Microsoft Windows Installer (MSI) 

Remote installations; for use with 
systems that support installations via 
command line, such as Microsoft SMS, 
and Altiris Deployment Solution. 

System Requirements 

Before you begin to install Protect-On, verify that your network and classroom computers 
meet all of the product system requirements. You must also have a valid serial number to 
activate a program. (You can install a 30-day evaluation version without a serial number). 

• Operating System: Windows 2000 Professional, XP Professional or Vista 

• Processor: 333Mhz or greater Intel® Pentium® class 

• Memory: 256MB RAM 

• Hard Disk: 100MB of available hard-disk space  

• Video Display: Super VGA (800×600) resolution 
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• Video Card: 4MB Video RAM or better 

• Network: 100Mbps Ethernet card 

Manual Installation 

After you have verified that your computer meets the system requirements, you can begin 
to install Protect-On. 

1. Log on to the computer as an administrator. 

2. Quit all programs. 

3. Quit all virus protection utilities or filters. 

4. Run the Protect-On Setup program. 

• If you are installing from a file that you downloaded, open the folder 
where you saved the Setup program, and then double-click 
ProtectOn2Installer.exe. 

• If you are installing from a CD, insert the CD in the proper drive, point to 
Protect-On, and then select Install Protect-On. 

5. Select the appropriate setup program: administrator or client (student 
computer). 

6. Click OK. 

7. Click Next to start the installation. 

8. Read and accept the licensing agreement. 

9. Enter your customer information. 

10. The wizard guides you through the installation; follow the instructions on 
screen. 
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Administrator Options 

 

If you are installing Protect-On for an administrator, you have the option 
to: 

• Change the destination folder where Protect-On is installed. 
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Client Options Setup 

 

If you are installing Protect-On on a classroom computer, you must: 

• Enter a client admin access key. (This allows administrators with the same 
key to access the student computer.) 

• Select which drives on the computer you want to protect. 

• Reserve a drive on the computer that Protect-On can use for internal 
operations.  

• (optional) Remove the Protect-On icon from the computer system tray (the 
notification area at the far right of the taskbar). 

• (optional) Create space on a selected drive that will not be protected. 
When you restore the computer, this space will not be affected. 

• (optional) Change the destination folder where Protect-On is installed. 

11. After you complete the installation, restart the computer and any virus 
protection utilities that you use. 
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Remote Installation with Microsoft Windows Installer 

You can use Microsoft Windows installer service (Msiexec.exe) and a package file 
(glpoadin.msi or glpoclin.msi) to install Protect-On on Windows 2000 and XP operating 
systems. Windows 98 also supports Microsoft Windows Installer technology, but requires 
that you install it separately. 

This technology is intended primarily for use in systems that support remote installation 
via command line, such as Microsoft SMS, Altiris Deployment Solution, and others. The 
package file may be placed in a shared directory as defined by these systems, and 
executed remotely on supported computers. 

Install Shield 

Before installation, verify that the Install Shield script engine is installed on the 
computer.  

To install ISScript1050, use the following string: 
msiexec /qn /i <pathname>\ISScript1050.msi 
 
where <pathname> is the directory path that contains the package, for example: 
msiexec /qn /i “C:\Program Files\installshield\driver\ISScript1050.msi” 

 

MSXML 4.0 

Before installation, verify that MSXML 4.0 is installed on the computer.  

To install MSXML 4.0, use the following string: 
msiexec /qn /i <pathname>\msxml.msi 
 
where <pathname> is the directory path that contains the package, for example: 
msiexec /qn /i C:\Downloads\MSXML\msxml.msi 
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Protect-On Command Line Parameters 

To install the Protect-On package file locally on a Windows-based computer, open the 
Command Prompt window and type the appropriate command line parameters. For 
example, to install the Protect-On Administrator in quiet mode (no user interaction), use 
the following string: 
msiexec /qn /i <pathname>\glpoadin.msi 
 
where <pathname> is the directory path that contains the package glpoadin.msi, for 
example: 
msiexec /qn /i C:\Protect-On\glpoadin.msi 
 
To uninstall Protect-On Administrator, use the following string: 
msiexec /qn /x {E41DEFD1-146F-4D03-97FA-3CB92A6CDEA5} 
 
To Uninstall Protect-On Client, use the following string: 
msiexec /qn /x {8BD9072F-DEEA-43D3-915F-3F5B5C09ECFF} UNINSTALL_PWD=xyz 

 

For a list of Windows Installer parameters, type msiexec at the command prompt. 
Protect-On parameters are described on the next page. 
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Parameters for Protect-On Administrators 

 

Property Name Meaning Possible Values 
MESERIAL License number required 

to activate Protect-On. 
<assigned by GenevaLogic> 

INSTALLDIR  The destination folder 
where Protect-On is 
installed. 

C:\Program Files\GenevaLogic\ 
Protect-On2 (default) 

CLASSROOMS_FILE This parameter defines a 
file containing Protect-
On2 Computer Group 
definitions.  
 

[main]—Begins the classroom file 
parameters. 
groups - The total number of 
groups [groupN]—Identifies a 
single group from the total where 
N is a sequential number.  
name - The name of the computer 
group as you want it to appear in 
Protect-On.  
computers - The total number of 
computers in [groupN].  
computerN - Identifies a single 
computer where N is a sequential 
number and the parameter is equal 
to the computer name. 
 
Example of 
CLASSROOMS_FILE: 
[main] 
groups=2 
 
[group1] 
name=LibraryLab 
computers=2 
computer1=LAB01 
computer2=LAB02 
[group2] 
 
name=LanguageLab 
computers=3 
computer1=LAB03 
computer2=LAB04 
computer3=LAB05 
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Parameters for Protect-On Clients 

 

Property Name Meaning Possible Values 
MESERIAL License number required to 

activate Protect-On. 
<assigned by GenevaLogic> 

INSTALLDIR  The destination folder where 
Protect-On is installed. 

C:\Program Files\GenevaLogic\ 
Protect-On2 (default) 

POC_ADMINPWD The client admin access key. 
This allows administrators with 
the same key to access the 
student computer. This is a 
required parameter. 

 

POC_PROTECT_[letter drive] Select the drives on the 
computer that you want to 
protect. Set this parameter to 1 
(POC_PROTECT_1) to protect 
the appropriate drive. 

POC_PROTECT_C or 
POC_PROTECT_Z 

POC_RESERVED_DRIVE The drive on the computer that 
is reserved for Protect-On to 
perform internal operations. 
This is a required parameter.

 

POC_HIDE_TRAY_ICON Remove the Protect-On icon 
from the computer system tray 
(the notification area at the far 
right of the taskbar). 

Set this parameter to 1 to remove 
the icon from the system tray. 

POC_ENABLE_UNPRSPACE The option to create space on a 
selected drive that will not be 
protected. When you restore the 
computer, this space will not be 
affected. 

Set this parameter to 1 to create 
unprotected space. 

POC_UPDS_LOCATION Location where the unprotected 
space is stored specified as a 
path. Example: C:\ 

 

POC_UPDS_SIZE The size (in megabytes) of the 
unprotected space. 

Minimum size is 16Mb (32Mb for 
FAT32), maximum size 100GB 
(32GB for FAT32). 

POC_UPDS_FILESYSTEM The file system type of the 
unprotected virtual drive you 
defined in 
POC_ENABLE_UNPRSPACE

NTFS or FAT32 

POC_UPDS_LETTER The drive letter assigned to the 
unprotected space.  
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Set Up Protect-On 

Before you can remotely turn protection on and off classroom computers, you must set up 
access between the administrator and the clients. In Protect-On, access keys are stored on 
both the administrator and classroom computers. When these keys match, the 
administrator has access to the computers. When the keys do not match, the administrator 
cannot access computers. The same is true for guests; however, their access to computers 
is limited. 

Assigning Access Keys 

When you install Protect-On on a classroom computer you assign it an access key, which 
you can later change. You then record the access key in the Protect-On Administrator. 
This authorizes the administrator to access the computer.  

Authorization Levels 

There are two levels of authorization you can assign to an administrator: Administrator or 
Guest. An administrator has full access to Protect-On features. A guest has limited 
access.  

Authorization Options 

 

In the following examples, both Karen and Paul are authorized to use Protect-On, Karen 
as an administrator and Paul as a guest. Karen has been assigned the administrator access 
key SL112, which authorizes her to access the computers in Student Lab 1. She also has 
access to all Protect-On features. 
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Paul has been assigned the guest access key Paul123, which authorizes him to access the 
computers in Student Lab 2. Paul is limited to the Manual Protection and Force 
Restore commands. 

 

Neither Karen nor Paul can access the other’s lab. 

Richard is the school administrator and he has access to the computers in both labs; both 
administrator access keys (SL112 and SL207) are stored on his computer. He also has 
full access to all Protect-On features. 
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Authorize an Administrator or Guest to Access a Client 

1. From the Edit menu, click Authorization. 

2. Select an authorization type: Administrator or Guest. 

An administrator has full access to Protect-On features. A guest has access 
to only the features Set Protection Manually and Force Restore. 

3. If you select Administrator, click Add, and then enter the access key assigned to 
the clients that you want to protect. You can enter more than one access key.  

If you select Guest, enter the access key assigned to the clients that you 
want to protect. A guest can have only one access key. 

4. Click OK. 

Change the access key for a classroom computer 

When you install Protect-On on a classroom computer you assign it an access key. 
Administrators and guests who share this access key can remotely turn protection on or 
off for this computer. The computer is unavailable to administrators and guests with 
different access keys.  

You can change a client access key for both administrators and guests from the Protect-
On Administrator. This is useful when you need to reassign a client to another 
administrator. 
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To Change a Client Access Key for an Administrator 

1. In the Computer Groups pane, click the group that displays the computer you 
want to change. 

2. In the Computers pane, select the computer.  

3. From the Actions menu, select Set Client Admin Access Key. 

4. Type the new key in the Enter Key and Confirm Key boxes.  

5. (optional) Select the Authorize this key for this Administrator check box to add 
this key to the list of access keys for the administrator. This is not necessary if the 
administrator already uses this key.  

6. Click OK. 

To Change a Client Access Key for a Guest 

1. In the Computer Groups pane, click the group that displays the computer you 
want to change. 

2. In the Computers pane, select the computer.  

3. From the Actions menu, select Set Client Guest Access Key. 

4. Type the new key in the Enter Key box. A guest may have only one access key. 
The key you enter replaces any key that was entered previously. 

5. Click OK. 

Require a Password to Start Protect-On 

You can assign a password to the Protect-On Administrator. This is useful when sharing 
a computer with other users who may not be administrators.  

1. From the Edit menu, click Set Administrator Password. 

2. Select the Require password to start Protect-On Administrator check box. 

3. Type your password in the Password and Confirm password boxes. 
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Setting Administration Password 
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Protect-On Administrator 

You use the Protect-On Administrator to restore your classroom computers to their last 
saved configuration. From here you can also arrange computers into different groups, 
view the restoration history of a selected computer, and wake up, restart, or shut down 
computers. 

Administrator Features Guest Features 

   

If you have administrator privileges, you can access all the features available in the 
Administrator. If you have guest privileges, you can access only the features Force 
Restore and Set Protection Manually. 

 

About the Computers Pane 

The Computers pane of the Protect-On Administrator displays the name, protection 
status, schedule, availability, IP address, and guest password for each computer in a 
selected network or group. 
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Administrator View 

 

Computer Name 

The name used to identify the computer on the network. 

Protection 

A computer can have one of the following protection statuses:  

• On: When you restart the computer it is restored to its last saved state; any 
changes you make to the computer are discarded. 

• Off: Any changes you make to the computer are saved, including at 
restart. 

• Manual: Any changes you make to the computer are saved for a specified 
amount of time, after which the computer is restored to its last saved state. 

• -- (no status): The computer is not available. For example, it does not 
have Protect-On installed or it has been turned off. 

Availability 

• Ready: The computer is available for protection to be turned on or off. 

• Unavailable: The computer is not available. For example, it is turned off 
or restarting. 
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• Waiting: The Protect-On Administrator is waiting for a response from the 
computer; the computer is temporarily unavailable. 

• Invalid Key: The computer has Protect-On installed; however, its access 
key is different than that of the administrator or guest.  

Schedules 

• Unprotect: The computer is scheduled to be unprotected for a certain 
amount of time, during which any changes you make are saved. 

• Restore: The computer is scheduled to be restored to its last saved 
configuration, after which any changes you make are discarded.  

• Res/Unpro: The computer is schedule to be unprotected and restored. 

IP Address 

The Internet Protocol (IP) address used to identify the computer across the Internet. 

Guest Password 

The password assigned to the computer that enables non-administrators (guests) to use 
only the Protect-On features Manual Protection and Force Restore. 

Sort Computers in the Computers Pane 

You can sort computers by any of the column headings in the Computers pane.  

1. From the Protect-On Administrator, select the group that contains the 
computers that you want to view.  

2. In the Computers pane, click the column heading you want to sort by, such as 
Computer Name or Availability. 

View a Computer's Change History  

Protect-On compiles an event log that records the changes that have been made to your 
computers, such as when they were last shut down or restored. Only changes that 
occurred in the last 24 hours appear in the log. 

To view the Event Log 

1. In the Computer Groups pane, click the name of the group that you want to 
view. The computers that belong to the group appear in the Computers pane. 
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2. Select a computer from the group.  

3. From the View menu, click Event Log. 

Event Log 

 

About Computer Groups 

Computer groups help manage the computers on your network. For example, you can use 
groups to organize computers that are in the same classroom or have the same operating 
system.  

Create a New Computer Group  

1. From the File menu, click New Group. 
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Group Properties 

  

2. In the Group Properties window, enter a name for your group.  

3. Add computers to the group. There are three ways to do this: 

• Click Browse and navigate to the computer that you want. Select the 
computer and click OK. 

• Click Add and manually input the computer that you want to add. Click 
OK. 

• Select the Populate by name check box and enter all or part of the 
computer name. This is useful if you use a particular naming convention 
to identify the computers on your network.  

4. Click OK. The group appears in the Computer Groups pane. 

Tips 

• To delete a group you no longer use, right-click the group folder and click 
Delete. 

• To rename a group, right-click the group folder and click Rename. 
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Add or Remove Computers from an Existing Group 

After you create a computer group, you can add or remove computers from it. 

To Add Computers 

1. In the Computer Groups pane, click the name of the group that you want to 
change.  

2. From the Actions menu, click Group Properties.  

3. From the Group Properties window, click Browse.  

4. Browse the networks and locate the computer you want to add.  

5. Select the computer and click OK. 

To Remove Computers 

1. In the Computer Groups pane, click the name of the group that you want to 
change.  

2. From the Actions menu, click Group Properties.  

3. Select a computer from the list and click Delete. 

Tips 

• You can select multiple computers at one time in the Computers pane. 
For consecutive computers, click the first computer, press and hold 
SHIFT, and then click the last computer. For nonconsecutive computers, 
press and hold CTRL, and then click each computer that you want. 

• You can also drag computers from the Computers pane to a group. 
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Working with Classroom Computers 

Turn Computer Protection On and Off 

When you turn protection on, students can make changes that have no lasting affect to the 
computer. Upon restart, the changes are discarded and the computer is restored to its last 
saved state; any viruses, unwanted files, or unauthorized computer programs that may 
have been added since that time are removed.  

When protection is turned off, any changes you make to a computer are saved. This is 
useful when you want to perform maintenance on your computers. For example, you may 
want to install program updates or upgrades.  

To Turn Computer Protection On 

1. In the Computer Groups pane, click the name of the group that has the 
computers you want to protect. The computers that belong to the group appear in 
the Computers pane. 

2. From the Actions menu, click Set Protection On (or  from Administrator 
toolbar). The computer restarts and turns protection on.  

To Turn Computer Protection Off 

1. In the Computer Groups pane, click the name of the group that has the 
computers you want to protect. The computers that belong to the group appear in 
the Computers pane. 

2. From the Actions menu, click Set Protection Off (or  from Administrator 
toolbar). The computer restarts and turns protection off.  
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Restore Classroom Computers 

At any time you can restore your protected classroom computers to their last saved 
configuration. The Force Restore command is available to Protect-On administrators and 
guests.  

1. In the Computer Groups pane, click the name of the group that has the 
computers you want to restore. The computers that belong to the group appear in 
the Computers pane. 

2. From the Actions menu, click Force Restore (or  from Administrator 
toolbar). The computer restarts and restores the computer. It also turns protection 
on.  

Tips 

• When protection is turned off, you cannot restore a computer. 

• You can select individual computers to restore instead of an entire group. 

• You can schedule a time for Protect-On to restore classroom computers 
automatically. 

Set Protection Manually 

When you set protection manually, students can safely restart computers without losing 
any data; changes made to the computer are saved for a specified amount of time, after 
which the computer is restored to its last saved state. The Set Protection Manually 
command is available to Protect-On administrators and guests. 

1. In the Computer Groups pane, click the name of the group that has the 
computers you want to protect. The computers that belong to the group appear in 
the Computers pane. 
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Setting Protection Manually 

 

2. From the Actions menu, click Set Protection Manually. 

Manual Protection Options 

 

3. Select the amount of time you want changes to be stored on the computers. 
Changes can be stored up to 15 days. 

4. Select the time at which you want the computers to be restored. 

5. Click OK. The computers now have a Protection status of Manual. 

Remotely Restart, Shut Down, or Wake Up Computers 

From the Protect-On Administrator you can turn computers on or off.  

1. In the Computer Groups pane, click the name of the group that has the 
computers you want to turn on or off. The computers that belong to the group 
appear in the Computers pane. 



  Working with Classroom Computers 25 

 

 

2. From the Actions menu, click the option you want: 

• Restart (or  from Administrator toolbar) 

• Shut Down (or  from Administrator toolbar) 

• Wake Up (or  from Administrator toolbar) 

Tips 

• When a computer is protected, it is restored to its last saved configuration 
when you restart it.  

• You can wake up computers remotely only if those computers support 
Wake on LAN and are on the same network subnet as the Protect-On 
Administrator. 

• You can select individual computers to restart or shut down instead of an 
entire group. 

Creating Schedules for Your Computers 

To Create a Restore Schedule 

You can schedule a time for Protect-On to restore your computers to their last saved 
configuration. For example, you may want to restore you computers nightly or at the end 
of each week. 

1. In the Computer Groups pane, click the name of the group that you want to 
schedule. The computers that belong to the group appear in the Computers pane. 
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Restore Options 

 

2. From the Actions menu, click Set Scheduled Restoration. 

3. In the Scheduled Restore window, select the Enable Scheduled Restore check 
box. 

4. Select the day and time at which you want the computers to be restored.  

5. Select what you want the computers to do after they are restored: Restart or Shut 
Down. 

6. (optional) Select the Set Protection On after restoration check box to turn 
protection on after the computers are restored. When protection is on, any changes 
made to the computer will be discarded the next time the computer is restored. 

7. (optional) Select the Warn users before restart check box to alert users that their 
computers are about to be shut down and restored. You can warn users up to ten 
minutes in advance. 

8. Click OK. The computers now have a Schedules status of Restore. 

To Schedule Unprotected Time for Your Computers 

You can schedule a time during which protection is turned off. This is useful when you 
want to perform regular maintenance on your computers. For example, you may want to 
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create a weekly schedule to install program updates or upgrades. Changes you make to a 
computer while it is unprotected are saved. 

1. In the Computer Groups pane, click the name of the group that you want to 
schedule. The computers that belong to the group appear in the Computers pane. 

Unprotect Options 

 

2. From the Actions menu, click Set Scheduled Unprotect. 

3. In the Scheduled Unprotect window, select the Enable Scheduled Unprotect 
option. 

4. Select the day and the start and end times, between which you want the computers 
to be unprotected.  

5. (optional) Select the Warn users before restart check box to alert users that their 
computers are about to shut down. You can warn users up to ten minutes in 
advance. 

6. (optional) Select the Block user input while unprotected check box to prevent 
users from making changes to the computer while it is unprotected. This is useful 
when you are running scripts from another computer or making other changes 
remotely. 

7. Click OK. The computers now have a Schedules status of Unprotected. 
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Accessing Protect-On from the Client 

Turn Protection On or Off from the Classroom Computer 

You can turn protection on or off from individual classroom computers in addition to the 
Protect-On Administrator. 

1. From the student computer, right-click the Protect-On icon  in the system tray 
(the notification area at the far right of the taskbar). If the icon is not available, 
use the keyboard shortcut CTRL+ALT+SHIFT+F12.  

2. In the Protect-On Client Authentication window, enter the access key for the 
student computer. 

3. In the Protect-On Client Options window, select to turn protection on or off the 
next time the student computer is restarted. The current status appears under the 
Protection State. 

Client Options 
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Remove the Protect-On Icon from a Student Computer System 
Tray 

You can remove the Protect-On icon that appears in the student computer system. 
Protect-On is always available from the student computer using the keyboard shortcut 
CTRL+ALT+SHIFT+F12.  

1. From the student computer, right-click the Protect-On icon in the system tray (the 
notification area at the far right of the taskbar). 

2. In the Protect-On Client Authentication window, enter the access key for the 
student computer. 

3. In the Protect-On Client Options window, clear the Show System Tray icon 
check box.  
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Protect-On Integration with Vision 

When the Protect-On Administrator is installed on a computer that is also a Vision 
Master (Teacher station), components are added that allow you to observe Protect-On 
status and access the Administrator directly from Vision. 

Protect-On Status in Vision 

When Protect-On is installed on Student computers, each thumbnail image of the 
Students in Vision bears a color-coded shield that displays protection status. 

 

In the example above, Stephen’s computer is protected (green shield) while Susan’s is not 
(red shield). 

Accessing Protect-On Administrator from Vision 

You may access the Protect-On Administrator directly from the Vision toolbar using the 
shield icon. 

 

Clicking this icon immediately opens the Protect-On Administrator. Please note that it is 
not possible to change Protect-On settings from within Vision; you must use the Protect-
On Administrator for that purpose. 
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